MCP250XX
Development Kit
User’s Guide
Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.

- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.

- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip's Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

- Microchip is willing to work with the customer who is concerned about the integrity of their code.

- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is intended through suggestion only and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. No representation or warranty is given and no liability is assumed by Microchip Technology Incorporated with respect to the accuracy or use of such information, or infringement of patents or other intellectual property rights arising from such use or otherwise. Use of Microchip’s products as critical components in life support systems is not authorized except with express written approval by Microchip. No licenses are conveyed, implicitly or otherwise, under any intellectual property rights.

Microchip is willing to work with the customer who is concerned about the integrity of their code.

Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.
# Table of Contents

**Preface** ............................................................................................................................. 1

**Chapter 1. Product Overview and Installation**
1.1 Introduction and Highlights ................................................................. 5  
1.2 What is the MCP250XX Development Kit? ............................................. 5  
1.3 System Requirements ......................................................................... 5  
1.4 MCP250XX Development Kit Components ......................................... 6  
1.5 MCP2515 Components ..................................................................... 7  
1.6 Hardware Installation ....................................................................... 10  
1.7 Software Installation ...................................................................... 11

**Chapter 2. MCP250XX Basic View Tutorial**
2.1 Introduction ....................................................................................... 13  
2.2 Highlights ........................................................................................ 13  
2.3 Setting up the Basic Template Evaluation Mode .................................. 13  
2.4 Establishing Communications ............................................................ 20  
2.5 Explaining the CAN Messages ........................................................... 22

**Chapter 3. MCP250XX Register View Tutorial**
3.1 Introduction ....................................................................................... 23  
3.2 Highlights ........................................................................................ 23  
3.3 Setting up the Register Template Evaluation Mode ............................. 23  
3.4 Establishing Communication .............................................................. 27  
3.5 Explaining the Register Template Windows ........................................... 27

**Chapter 4. Programming the MCP250XX User Defaults**
4.1 Introduction ....................................................................................... 29  
4.2 Highlights ........................................................................................ 29  
4.3 Device Programmer .......................................................................... 29  
4.4 Programming via the ICSP™ Connector ............................................... 34

**Chapter 5. Other Capabilities of the Development Board**
5.1 Introduction ....................................................................................... 35  
5.2 Highlights ........................................................................................ 35  
5.3 Oscillator Configurations ................................................................ 35  
5.4 Node A Prototyping Area and Header Pinout ....................................... 36  
5.5 External Bus Connections ................................................................. 37
Appendix A. Schematics and Layouts

A.1 Introduction ............................................................................................. 39
A.2 VPP Step-up Regulator ........................................................................... 40
A.3 Clock and Data for Programming ........................................................... 41
A.4 PC Node ................................................................................................. 42
A.5 CAN Physical Layer ................................................................................ 43
A.6 Node A and Node B ................................................................................ 44
A.7 Caps Page .............................................................................................. 45

Index ..............................................................................................................................47

Worldwide Sales and Service .................................................................................48
Preface

INTRODUCTION AND HIGHLIGHTS

This section provides general information that will be useful to know before using the MCP250XX Development Kit and touches on the following topics:

• About This Guide
• Recommended Reading
• Troubleshooting
• The Microchip Internet Web Site
• Customer Support

ABOUT THIS GUIDE

Document Layout

The User’s Guide layout is as follows:

• Chapter 1: Product Overview and Installation – details the hardware and software components and discusses installation procedures.
• Chapter 2: MCP250XX Basic View Tutorial – covers some of the key elements of the MCP250XX by going through the steps for setting up and running the demonstration program.
• Chapter 3: MCP250XX Register View Tutorial – details the demonstration software and the CAN system, as well as discussing the steps required to successfully communicate with the MCP250XX while in the Register template.
• Chapter 4: Programming the MCP250XX Using the Development Board – describes the procedure for programming the MCP250XX using the programming circuitry and special software.
• Chapter 5: Other Capabilities of the MCP250XX Development Kit - details the other capabilities of the MCP250XX Development Kit, including configuring the board for multiple oscillators, connecting the board to the MCP2515 development board and connecting the board to external CAN busses.

Appendices

• Appendix A: Schematics and Layouts – lists the schematics and layout diagrams for the MCP250XX Development Kit.
• Index – cross-reference listing of terms, features and sections of this document.
• Worldwide Sales and Service – provides the address, telephone and fax numbers for Microchip Technology Inc. sales and service locations throughout the world.

Updates

Since Microchip tools are constantly evolving to meet customer needs, some software dialogs and/or tool descriptions may differ from this document. Please refer to the Microchip web site to obtain the latest documentation available (www.microchip.com).
RECOMMENDED READING

For more information regarding the MCP250XX devices and other CAN related topics, the following are recommended reading. The following data sheets may be downloaded from our internet web site at www.microchip.com.

*MCP2502X/2505X Data Sheet (DS21664)*

This data sheet provides detailed information regarding the MCP250XX CAN I/O Expanders.

*MCP2515 Data Sheet (DS21291)*

This data sheet provides detailed information regarding the MCP2515 Stand-Alone CAN Controller, which is the master node on the board.

*PRO MATE® II User’s Guide (DS30082)*

This manual contains a section explaining how to program the MCP250XX devices using the specified socket module.

*MCP250XX Programming Specification (DS20072)*

This specification explains the requirements for programming the MCP250XX using the ICSP™ protocol.

*AN815 – Understanding the MCP250XX Devices (DS00815).*

*AN816 – A CAN System Using Multiple MCP250XX I/O Expanders (DS00816).*

*AN713 – An Introduction to the CAN Protocol Application Note (DS00713)*

This application note provides “the basics” for those not familiar with the CAN protocol.

*AN754 – Understanding Microchip’s CAN Module Bit Timing Application Note (DS00754)*

This application note is an in-depth discussion of bit timing using Microchip’s CAN module.

*A CAN Kingdom by Lars-Berno Fredriksson (Kvaser AB)*

This document covers the CAN Kingdom Specification and should help give some insight into the main software and some of the menu items that refer to CAN Kingdom-specific functions. For more information, please visit CAN Kingdom web site at www.cankingdom.org

*CANKing Help Files*

The help files are a good resource for answering some common questions about the MCP250XX Development Kit, including the CAN Kingdom-specific menu items.

*README Files*

Contains the latest information on the MCP250XX evaluation system.

*Microsoft® Windows® Manuals*

These manuals assume that users are familiar with the Microsoft Windows operating system. Many excellent references exist for this software program and should be consulted for general operation of the Windows® operating system.

TROUBLESHOOTING

See the README files for information regarding common problems not addressed in this user’s guide.
THE MICROCHIP INTERNET WEB SITE

Microchip provides easy access to our documentation and on-line support through our World Wide Web Site at www.microchip.com. You can download files from the web site or from our FTP site at ftp://ftp.microchip.com.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Corporate Applications Engineer (CAE)
• Hot Line

Customers should call their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. See the back cover for a listing of sales offices and locations.

Corporate applications engineers (CAEs) may be contacted at:

(480) 792-7627.

In addition, there is a Systems Information and Upgrade Line. This line provides system users a listing of the latest versions of all of Microchip’s development systems software products. Plus, this line provides information on how customers can receive any currently available upgrade kits.

The Hot Line numbers are:

1-800-755-2345 for U.S. and most of Canada, and
1-480-792-7302 for the rest of the world.
1.1 INTRODUCTION AND HIGHLIGHTS

This chapter provides an overview of the MCP250XX Development Kit and covers the following topics:

• What is the MCP250XX Development Kit?
• System Requirements
• MCP250XX Development Kit Components
• MCP2515 Components
• Hardware Installation
• Software Installation

1.2 WHAT IS THE MCP250XX DEVELOPMENT KIT?

The MCP250XX Development Kit is an evaluation, demonstration and development tool for Microchip Technology’s 14-pin CAN I/O Expanders. The MCP250XX can be evaluated easily by installing the provided software and running the demonstration program. Furthermore, development can be accomplished by utilizing the bare CAN node with the prototyping area, as well as with the on-board device programmer.

The development board has the ability to program the user-defined defaults by using the device programmer module and the supplied software. Alternatively, the In-Circuit Serial Programming™ (ICSP™) protocol can be used to program the MCP250XX using the 5-pin header, which is connected to a 14-pin socket on the board. See the MCP250XX Programming Specification (DS20072) for details on programming via ICSP.

Some of the key features of the MCP250XX Development Kit include:

• Evaluation of Microchip’s CAN I/O Expanders
• Programming the MCP2505X devices using supplied software
• Programming the MCP2505X devices via the ICSP protocol
• Connectable to external CAN networks

1.3 SYSTEM REQUIREMENTS

To take full advantage of the MCP250XX features, you must install the supplied demonstration/evaluation software on a host computer. The MCP250XX requires:

• Microsoft Windows 95/98/ME/NT/2000 operating system
• One free parallel port
• CD-ROM drive
1.4 MCP250XX DEVELOPMENT KIT COMPONENTS

The MCP250XX Development Kit contains:

- MCP250XX Development Board
- MCP250XX Development Kit User’s Guide
- MCP250XX Development Kit CD-ROM with demo and programming software
- Parallel port cable
- 9V DC power supply adapter
- Warranty/Registration card
- Three MCP25020 CAN I/O Expanders
- Three MCP25050 CAN I/O Expanders

FIGURE 1-1: MCP250XX DEVELOPMENT KIT
1.5 MCP2515 COMPONENTS

The MCP2515 consists of four main parts (see Figure 1-4):

1. PC Node
2. Node A
3. Node B
4. Device Programmer

1.5.1 PC Node

The PC Node is the master node for the demonstration program that controls Node B. This node contains a MCP2515 Stand-Alone CAN Controller that is controlled by the host PC via a custom parallel port interface.

**Note:** All three nodes are connected to a common CAN bus that has external connections via the DB9 connector.

1.5.2 Node A

Node A is a bare CAN node next to the prototyping area. This node is used for MCP250XX prototyping and can also be used to program the user defaults via the ICSP protocol. See Figure 1-2 for pinout description.

**FIGURE 1-2:** NODE A PINOUT
1.5.3 Node B

Node B is the slave node for the demonstration program. Analog inputs (potentiometers), PWM outputs (piezo buzzer and incandescent lamp) and digital inputs (push buttons) are all connected to the MCP25050 device. It responds to inputs and CAN messages to demonstrate device functionality. See Figure 1-3 for the pinout description.

FIGURE 1-3: NODE B PINOUT

![Node B Pinout Diagram](image-url)
1.5.4 Device Programmer

The Device Programmer module is used with PC software to configure the user-defined defaults.

**FIGURE 1-4: MCP250XX DEVELOPMENT BOARD**

1.5.5 Key Areas of the MCP2515

There are a few key areas on the board. Figure 1-4 illustrates these areas, while Table 1-1 details them.

**TABLE 1-1: MCP250XX BOARD LAYOUT**

<table>
<thead>
<tr>
<th>Key Areas</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB25</td>
<td>DB25 is the connection to the host PC interface. The PC controls both the PC Node and the Device Programmer circuit.</td>
</tr>
<tr>
<td>U6</td>
<td>U6 is the CAN Controller (MCP2515) of the PC Node that is controlled by the host PC.</td>
</tr>
<tr>
<td>U15, J5 and JP4</td>
<td>U15 is the prototyping node. J5 is the ICSP™ header for U15. JP4 jumpers board power to the Vdd pin of U15 and should be removed if using J5 (ICSP header) to isolate U15 from the rest of the board during In-Circuit Serial Programming™.</td>
</tr>
<tr>
<td>U14</td>
<td>The MCP250XX for the demonstration program. Connected to the potentiometers, piezo, buttons and lamp.</td>
</tr>
<tr>
<td>U3</td>
<td>U3 is the socket for programming the user-defined defaults using the programming software.</td>
</tr>
<tr>
<td>Y1, Y2, Y3, JP1 and JP2</td>
<td>Y1, Y2 and Y3 are the oscillator sockets for each of the three CAN nodes. By default, all of the Yx outputs are connected together (JP1 and JP2 are shorted via a trace on the back of the board) and only Y1 is populated (i.e., Y1 clocks all three CAN nodes). To separate the oscillator sockets, the traces shorting JP1 and JP2 must be cut.</td>
</tr>
<tr>
<td>U11, U12, U13, J3 and J4</td>
<td>U11-U13 are the CAN drivers all connected to a common CAN bus. The two DB9s (J3 and J4) are the external CAN bus connections. Only J4 is populated.</td>
</tr>
<tr>
<td>D2, D3, D4 and D5</td>
<td>CAN traffic indicator LEDs. D2 represents all traffic. D3-D5 represent transmitted traffic of each of the three nodes.</td>
</tr>
</tbody>
</table>
1.6 HARDWARE INSTALLATION

1.6.1 Connecting the DB25 Cable

The included DB25 cable is a male-to-male configuration and plugs into the parallel port of the host PC. Figure 1-5 shows the pin configuration.

FIGURE 1-5: DB25 PIN CONFIGURATION

1.6.2 9V Power Supply Adapter

The power supply is rated at 9V, 750 mA DC.

1.6.3 DB9 External CAN Bus Connectors (optional)

The DB9 connector, as shown in Figure 1-6, is used to connect the MCP2515 to an external CAN bus and is not necessary for basic board operation.

Note: Only the DB9 at J4 is populated. J3 is available as needed.

FIGURE 1-6: DB9 CAN CONNECTOR
1.7 SOFTWARE INSTALLATION

Insert the MCP250XX Development Kit CD-ROM into the CD-ROM drive.

1.7.1 Auto-run Enabled

If auto-run is enabled, the installation program will automatically start. Follow the instructions on the screen to install the software.

1.7.2 Auto-run Not Enabled

If auto-run is not enabled:

1. Click the Start button and select Run. Enter `d:\setup.exe` (where `d:\` is your CD-ROM drive). Click OK. Or alternatively, find the CDROM drive using "Windows Explorer" and double click "setup.exe".

2. Follow the online instructions to install the software.

Note: Windows NT® and Windows 2000 users must have administrative privileges in order to install the MXLAB® software.
Chapter 2. MCP250XX Basic View Tutorial

2.1 INTRODUCTION

This tutorial discusses the evaluation portion of the kit, details the demonstration software (Basic template), CAN system (PC Node and Node B) and covers the steps required to successfully run the demonstration network.

The user defaults for Node B are preprogrammed at the factory. Therefore, no user default programming is necessary. No discussion of programming user defaults will take place in this chapter, as this is detailed in Chapter 4. “Programming the MCP250XX User Defaults”.

Note: The software must be installed and the hardware connected to run the demonstration program.

2.2 HIGHLIGHTS

This chapter covers the following topics:

• Setting up Evaluation mode
• Establishing communications
• Explaining the CAN messages

2.3 SETTING UP THE BASIC TEMPLATE EVALUATION MODE

The MCP250XX Development Kit’s “Basic” template contains the following major elements:

1. **Menu Bar** (Figure 2-1) – The layout is typical of most Windows menu bars.
2. **PC Node Bit Timing and Mode** (Figure 2-2) – The bit timing and the mode of operation (Normal and Configuration) for the MCP2515 (PC Node) are configured with this window.
3. **Board Status** (Figure 2-3) – Indicates if the board is connected to the PC and also indicates the parallel port address used.
4. **Message Format Window** (Figure 2-4) – Selects how CAN messages are formatted and interpreted. The default is “Standard Text Format” and is used for the demonstration program. The other format is used with the CAN Kingdom higher layer protocol.
5. **Bus Monitor Window** (Figure 2-5) – Also known as the “Output” window. This window shows all bus traffic.
6. **MCP250XX Demonstration** (Figure 2-6) – This window is the graphical interpretation of Node B (the demonstration node).

**FIGURE 2-1: MENU BAR**
FIGURE 2-2: PC NODE BIT TIMING AND MODE

MCP 2515 CAN Controller

Bus Statistics
Bus Load
0%
RX messages: 0
TX messages: 4

Bus Parameters
Bus Speed: 125,000 kbit/s
Bit timing: Q=6, S1=5, S2=3, SP=62.5%, SJW=1

On Bus
Off Bus
Error Passive
Error Warning
Clean

FIGURE 2-3: BOARD STATUS

MCP 2515 Evaluation Board
Eval Board Status
Connected.
MCP2510 is in Normal Mode.
Parallel Port Address: $378
Reset Board
FIGURE 2-4: MESSAGE FORMAT WINDOW

FIGURE 2-5: BUS MONITOR WINDOW
FIGURE 2-6: MCP250XX DEMONSTRATION WINDOW

Status:
- Module On Bus
- Application overrun

Period:
- Period: 1000 ms
- Set

Periodic Read:
- Analog 0 Input:
- Analog 1 Input:
  - GP4: Led0
  - GP5: Led1
  - GP6: Led2

Periodic Write:
- PWM1 Frequency:
- PWM2 Duty Cycle:
2.3.1 Starting the Program

1. Start the software by any of the following:
   • From the “Start” menu, select “Programs > Microchip > CANKing”
   • Select “C:\Program Files\Microchip\Mcan\WC32.exe”
   • Double-click on the desktop icon for the MCP250XX Development Kit

2. A notice will appear warning of the potential undesired results if connecting to an existing CAN bus (Figure 2-7). Select “OK, I know what I am doing”.

3. A dialog will appear asking if a new template or a saved project should be opened. Select “New Template” (Figure 2-9).

4. When the template dialog appears, select “MCP250XX Evaluation” (Figure 2-10).

The software is now started. There are a few other options that the user may want to configure for convenience before saving the project and capturing the defaults.

2.3.2 Setting the Numeric Base for Transmit and Monitor Windows

The default numeric base can be changed, as desired, for both the Transmit Buffer window and the Bus Monitor window. Base 16 (hex) numbers are preceded by a “$”.

2.3.2.1 TRANSMIT BUFFER WINDOW

The numeric base for the transmit buffer is configured by selecting “Options > Global...” from the menu. Check desired numeric base.

2.3.2.2 BUS MONITOR WINDOW

If the Select Formatters window is not visible, select it from the View menu. Highlight (do not uncheck) Standard Text Format in the Select Formatters window. Click Properties and check the desired numeric base (see Figure 2-8).

A few other items must be addressed before proper communication can occur. These are discussed in the next section.
FIGURE 2-7: WARNING ON START-UP

If you connect this tool to a real CAN system, you may cause the system to malfunction or behave in unexpected ways. Depending on the CAN system, this might mean catastrophic failures including personal injuries.

FIGURE 2-8: CHANGING NUMERIC BASE FOR BUS MONITOR

Hexadecimal, DeltaT=Yes

Text Formatter Options

- Numeric Base
  - Octal
  - Decimal
  - Hexadecimal

- Miscellaneous
  - Delta Times
FIGURE 2-9: OPEN DIALOG

FIGURE 2-10: TEMPLATE DIALOG
2.4 ESTABLISHING COMMUNICATIONS

When the software is started from a new template (as it must be the first time it is started), some steps must be taken to insure proper operation and to set up the software defaults. These defaults can be saved by saving the template as a project and opening the project in subsequent sessions.

2.4.1 Configure Parallel Port

The board status (including parallel port address and connection status) is indicated in the Board Status window (Figure 2-3). Assuming the port address, as displayed in the window, matches the address as configured by the PC, the board status should indicate “connected”, with the indicator in the window being green.

If the status indicator is red and indicates “not connected”, check the port address. To change the port address that the software uses, select “Options > MCP2515” and enter the correct port address in the appropriate dialog box (Figure 2-11).

**Note:** Port address is entered as a hex value.

**FIGURE 2-11: PC NODE OPTIONS**

![PC Node Options Dialog Box](image)

2.4.2 Match Oscillator Frequency with Board

The CAN data rate is a function of the oscillator frequency. Therefore, the proper oscillator frequency must be set in order for the software to calculate the CAN data rate correctly. Open the same window that was opened to set the parallel port address (Figure 2-11). The frequency of oscillation units are displayed in kilohertz (kHz).
2.4.3 Configuring the Output Window Display Format

The Output (Bus Monitor) window (Figure 2-5) can display the CAN messages in five different ways:

1. **Fixed Positions** – Messages with the same identifier maintain a fixed position (slot) within the window. The data and time-stamp update normally. To turn fixed positions on/off, right-click the mouse while the cursor is over the Output window area and select “Fixed Positions”.

2. **Dynamic Positions (Fixed Positions = off)** – Each new message is displayed below the previous message, regardless of the identifier. This mode is activated by unchecking Fixed Positions (right mouse click).

3. **Auto-Scroll** – Keeps the Output window from auto-scrolling to the most recent message (bottom message). This is useful when messages are being regularly received and the user would like to observe old messages at the top of the buffer without having the focus shift to the end of the buffer each time a message is received.
   To activate, right-click the mouse while the cursor is over the Output window and select “Auto-Scroll”.

4. **Delta Time** – This is a time-stamp that indicates the time(s) between two messages with the same identifier. Delta time is activated as follows (Figure 2-8):
   If the Select Formatters window is not visible, select it from the View menu. Highlight (do not uncheck) the “Standard Text Format” option in the Select Formatters window. Click Properties and check the “Delta Times” box.

5. **Free-Running Time** – A free-running time-stamp between messages with the same identifiers. This mode is activated by unchecking the “Delta Times” box.
2.5 EXPLAINING THE CAN MESSAGES

At this point, the two nodes (PC Node and Node B) should be communicating normally and a message should be showing up in the Output window (Figure 2-5) at regular intervals. Pushing GP4, GP5 or GP6 causes other messages to show up in the Output window, with the status being reflected graphically in the Demo window. Turning the potentiometers will cause the data fields to change.

This section explains the CAN messages as seen in the Output (Bus Monitor) window.

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Length</th>
<th>Data</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x008</td>
<td>3</td>
<td>“Write Register” Input Message</td>
<td>DB0 (address) is either 0x23 or 0x26 (PR1 or PWM2DCH).</td>
</tr>
<tr>
<td>0x018</td>
<td>8</td>
<td>Read A/D Regs</td>
<td>“Read A/D Regs” IRM followed by OM.</td>
</tr>
<tr>
<td>0x280</td>
<td>0</td>
<td>None</td>
<td>On-bus message.</td>
</tr>
<tr>
<td>0x290</td>
<td>8</td>
<td>Read A/D Regs</td>
<td>A/D Threshold Detection (R20, POT and PWM2 duty cycle).</td>
</tr>
<tr>
<td>0x7FF</td>
<td>0</td>
<td>None</td>
<td>Command Acknowledge in response to IM.</td>
</tr>
</tbody>
</table>
Chapter 3. MCP250XX Register View Tutorial

3.1 INTRODUCTION

A few topics covered in this chapter were also covered in the last chapter detailing the Basic template tutorial. To avoid duplication, the appropriate sections of Chapter 2 “MCP250XX Basic View Tutorial” will be referenced.

This chapter details the demonstration software (Register template) and CAN system (PC Node and Node B). It also covers the steps required to successfully communicate with the MCP250XX while in the Register template.

Note: The software must be installed, and the hardware connected, to run the demonstration program.

3.2 HIGHLIGHTS

This chapter covers the following topics:

• Setting up the Evaluation Mode
• Establishing Communications
• Explaining the Windows

3.3 SETTING UP THE REGISTER TEMPLATE EVALUATION MODE

The MCP250XX Development Kit's “Register” template contains the following major elements that will be discussed, in detail, later in this chapter:

1. The Menu Bar, PC Node Bit Timing and Mode and Board Status windows are all discussed in Section 2.3 “Setting up the Basic Template Evaluation Mode”.
2. MCP250XX Filters – Used to set up and test the MCP250XX mask and filters.
3. MCP250XX Error Status – Used to read the current Transmit and Receive Error Counters (TEC and REC), as well as the EFLG register.
4. MCP250XX Physical Layer – Displays the bit timing registers (CNF1, CNF2 and CNF3).
5. MCP250XX Command Messages – Implements the command messages as described in the data sheet. Information Request Messages (IRM), output and input messages are all represented in this window to enable the main functionality of the MCP250XX.
FIGURE 3-1: MCP250XX FILTERS

FIGURE 3-2: MCP250XX ERROR STATES
FIGURE 3-3: MCP250XX PHYSICAL LAYER
3.3.1 Starting the Program

Because the start procedures are the same as in Section 2.3.1 “Starting the Program”, there are references to figures in Chapter 2 “MCP250XX Basic View Tutorial” in this section.

1. Start the software by any of the following:
   • From the “Start” menu, select “Programs > Microchip > CANKing”
   • Or select “C:\Program Files\Microchip\Mcan\WC32.exe”
   • Or double-click on the desktop icon for the MCP250XX Development Kit
2. A notice will appear warning of the potential undesired results if connecting to an existing CAN bus (Figure 2-7). Select “OK, I know what I am doing”.
3. Next, a dialog will appear asking if a new template or a saved project should be opened. Select “New Template” (Figure 2-9).
4. When the template dialog appears, select “MCP250XX Evaluation” (Figure 2-10).
3.3.2 Setting the Numeric Base for Bus Monitor Window

If the Select Formatters window is not visible, select it from the View menu. Highlight (do not uncheck) “Standard Text Format” in the Select Formatters window. Click Properties and check the desired numeric base (see Figure 2-8).

A few other items must be addressed before proper communication can occur, as discussed in the next section.

3.4 ESTABLISHING COMMUNICATION

Because the method for establishing communications is exactly the same as the last chapter, please refer to Section 2.4, “Establishing Communications”.

3.5 EXPLAINING THE REGISTER TEMPLATE WINDOWS

The Register template provides access to all of the user registers by using the command messages as defined in the data sheet.

3.5.1 General Information

There are three different ways to enter values into the windows, depending on the window function:

1. Entering byte value in the appropriate box.
2. Clicking up/down counters to increase/decrease the value by one.
3. Double-clicking the desired bit location to toggle the bit to its opposite state.

The register bit names will be displayed for the location directly under the mouse pointer (Physical Layer and Configuration windows only).

3.5.2 MCP250XX Filters Window

The MCP250XX Filters window allows the user to read, modify and test the mask and filters settings. Care must be taken when modifying the mask and filter settings, as all, or partial communications with the MCP250XX may be lost due to improper filter and mask settings.

Mask and filter settings can be tested against various identifiers simply by entering the desired identifier in the Test Identifier window and pressing the “Test Buf” button. This tests the entered identifier with the entered mask and filter settings, indicating pass/fail for each filter.

Example 3.1: Figure 3-1 shows a test where the mask is configured to accept IDs of Eh and Fh only (bit 0 = 0 = “don't care”).
3.5.3 MCP250XX Error States

The current Receive and Transmit Error Counters (REC and TEC) can be read, as can the EFLG register. The is the same as the “Read CAN Error” Information Request Message (IRM).

3.5.4 MCP250XX Physical Layer

The bit timing (CNF registers) cannot be changed from the default values. However, these registers can be read and displayed along with the parsed prescaler and Tq settings.

3.5.5 MCP250XX Command Messages

This window implements the command messages as described in the data sheet. Both IRMs and input messages can be implemented by selecting the appropriate radio button (see Figure 3-4).

This window also gives the added functionality of reading and/or writing individual registers. Reading individual registers is actually an IRM that contains the desired register (e.g., reading IOINTEN register is actually a “Read Control Register” IRM command with the resulting output message). Writing an individual register is a “Write Register” input command.
Chapter 4. Programming the MCP250XX User Defaults

4.1 INTRODUCTION

The user memory for MCP250XX devices is initially blank when shipped from the factory. The user must program the user memory with user-defined defaults. There are three methods for programming the user memory.

1. Using MPLAB® IDE with the PRO MATE® II device programmer and the MCP250XX socket module.
2. Using the device programmer circuit on the MCP2515 with the programming software.
3. In-Circuit Serial Programming™ (ICSP™) while following the MCP250XX Programming Specification (DS20072).

4.2 HIGHLIGHTS

The MCP250XX Development Kit supports two methods for programming the user defaults.

1. Using the Device Programmer circuit with the programming software.
2. Node A has an ICSP connector.

4.3 DEVICE PROGRAMMER

A device programmer circuit is built into the board to allow the user to easily program MCP250XX devices with the existing board (i.e., PRO MATE II is not needed).

4.3.1 Circuit Description

The programming circuitry is designed to use the ICSP methodology as defined in the MCP250XX Programming Specification (DS20072). The circuitry routes all of the required signals, including the 13V VPP signal that is generated by a step-up voltage regulator. Figure 4-1 shows the pinout for the MCP250XX socket in the device programmer circuitry.
4.3.2 PC Software

The programming circuitry is controlled by a host PC application through the DB25 connector. The PC application is a graphical interface that allows the device to be quickly and easily configured with the user defaults. Figure 4-2 shows the main screen, which is used to navigate to all of the MCP250XX device peripherals that can be configured with the defaults.

The other screens, as shown in Figure 4-3 thru Figure 4-7, are used to configure all peripherals. Together, both the hardware and software use the ICSP methodology as described in the MCP250XX programming specification.

The software has the ability to save user defaults into IHEX8 format, which can be imported to the PRO MATE II device programmer through MPLAB® IDE for programming the MCP250XX devices.
Programming the MCP250XX User Defaults

FIGURE 4-2: PROGRAMMER SOFTWARE MAIN SCREEN

FIGURE 4-3: USER MEMORY

User Memory Registers

Address (hex)

90 00 00 00 00 00 00 00
90 35 36 37 38 39 3A 3B 3C
00 3D 3E 3F 40 41 42 43 44

OK Cancel
FIGURE 4-6: A/D MODULE

FIGURE 4-7: GPIO MODULE
4.4 PROGRAMMING VIA THE ICSP™ CONNECTOR

There is an ICSP connector on Node A that can be used to program the user defaults with an external programmer. To insure successful programming, the MCP250XX Programming Specification (DS20072) must be adhered to.

The JP4 jumper allows the MCP250XX socket to be isolated from board power so the programmer does not have to drive the board while programming.

FIGURE 4-8: PROGRAMMING VIA THE ICSP™ CONNECTOR
Chapter 5. Other Capabilities of the Development Board

5.1 INTRODUCTION

The capabilities and configurations of the MCP2515 are discussed in this chapter.

5.2 HIGHLIGHTS

This chapter discusses:
• Oscillator Configurations
• Node A Prototyping Area and Header Pinout
• External CAN Bus Connections

5.3 OSCILLATOR CONFIGURATIONS

The MCP2515 is configured, by default, to use a common oscillator for all three CAN nodes. While there are three oscillator sockets, only one is populated. The oscillator sockets are connected together with their outputs. The two jumpers (JP1 and JP2) can be used to disconnect the outputs and use individual oscillators for the nodes. The jumpers are shorted by a trace on the bottom of the board by default. These traces can be cut and jumper pins can be installed to control the oscillator output wiring. See Figure 5-1 for details on the oscillator configurations.

FIGURE 5-1: OSCILLATOR SOCKET LAYOUT

![Oscillator Socket Layout Diagram]
5.4 NODE A PROTOTYPING AREA AND HEADER PINOUT

In addition to ICSP capabilities, Node A can also be used for prototyping custom MCP250XX configurations. This node has a prototyping area as well as a header that can be used for probing the MCP250XX pinout. Figure 5-2 shows the layout of the header.

**Note:** JP4 must be shorted to enable board power to the MCP250XX socket.

**FIGURE 5-2: NODE A HEADER LAYOUT**

![Node A Header Diagram]
5.5 EXTERNAL BUS CONNECTIONS

The MCP2515 can be connected to an external CAN bus through the DB9(s). The DB9 pinout is the same as the defacto standard, as recommended by the CAN in Automation (CiA) group. At a minimum, CANH (pin 7) and CANL (pin 2) must be connected. However, CAN_GND (pin 3) and CAN_V+ (pin 9) may also be connected to supply power to and from another board. Table 5-1 and Figure 5-3 show the pinout and connector, respectively.

**Note:** If supplying power to or from the MCP2515, be sure the voltage regulator specification is not violated.

### TABLE 5-1: CAN CONNECTOR PINOUT

<table>
<thead>
<tr>
<th>Pin#</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>—</td>
<td>Reserved</td>
</tr>
<tr>
<td>2</td>
<td>CANL</td>
<td>CAN low bus line</td>
</tr>
<tr>
<td>3</td>
<td>CAN_GND</td>
<td>CAN ground</td>
</tr>
<tr>
<td>4</td>
<td>—</td>
<td>Reserved</td>
</tr>
<tr>
<td>5</td>
<td>N/C</td>
<td>Not connected</td>
</tr>
<tr>
<td>6</td>
<td>N/C</td>
<td>Not connected</td>
</tr>
<tr>
<td>7</td>
<td>CANH</td>
<td>CAN high bus line</td>
</tr>
<tr>
<td>8</td>
<td>—</td>
<td>Reserved</td>
</tr>
<tr>
<td>9</td>
<td>CAN_V+</td>
<td>CAN power</td>
</tr>
</tbody>
</table>

### FIGURE 5-3: EXTERNAL CAN BUS CONNECTOR

![External CAN Bus Connector Diagram]
NOTES:
Appendix A. Schematics and Layouts

A.1 INTRODUCTION

This appendix contains the schematics and layouts for the MCP250XX Development Kit. Diagrams included in this appendix include:

- VPP Step-Up Regulator circuit
- Programming Clock/Data Logic circuit
- PC Interface/CAN Node circuit
- CAN Bus Interface circuit
- Node A/Node B circuit
- Capacitors circuit
A.2 VPP Step-up Regulator

**FIGURE A-1: VPP STEP-UP REGULATOR CIRCUIT**
A.3 CLOCK AND DATA FOR PROGRAMMING

FIGURE A-2: PROGRAMMING CLOCK/DATA LOGIC CIRCUIT
A.4 PC NODE

FIGURE A-3: PC INTERFACE/CAN NODE CIRCUIT
A.5 CAN PHYSICAL LAYER

FIGURE A-4: CAN BUS INTERFACE CIRCUIT

```
```

© 2004 Microchip Technology Inc.

DS51266C-page 43
A.6 NODE A AND NODE B

FIGURE A-5: NODE A/NODE B CIRCUIT
FIGURE A-6: CAPACITORS CIRCUIT
## Index

### B
- Basic View Tutorial:
  - Setting the Numeric Base ........................................ 17
  - Setting up the Basic Template .................................. 13
  - Starting the Program ........................................... 17
- Board Components .................................................. 7

### C
- CAN Messages ....................................................... 22
- Customer Support .................................................. 3

### D
- Document Layout .................................................... 1

### E
- Establishing Communications ..................................... 20

### H
- Hardware Installation ................................................ 10

### I
- Installing:
  - Hardware .......................................................... 10
  - Software .......................................................... 11

### K
- Kit Components ....................................................... 6

### M
- Microchip Internet Web Site ........................................ 3

### O
- Other Capabilities:
  - External Bus Connections ..................................... 7
  - External CAN Bus Connector .................................... 7
  - Oscillator Configurations ....................................... 35
  - Prototyping Area .................................................. 36

### P
- Product Overview and Installation:
  - Board Components ................................................ 7
  - Key Areas of the Development Board .......................... 6
  - Kit Components .................................................... 6
  - System Requirements ............................................. 5
- Programming the User Defaults:
  - Device Programmer ............................................... 29
  - PC Software .......................................................... 30
  - Programming via the ICSP™ Connector ....................... 34

### R
- Recommended Reading ............................................... 2
- Register Template Windows ....................................... 27
- Register View Tutorial:
  - Setting the Numeric Base ....................................... 27
  - Setting Up the Evaluation Mode ................................. 23
  - Starting the Program ............................................. 26

### S
- Schematic and Layouts ............................................... 39
- Software Installation ............................................... 11
- System Requirements ................................................ 5

### T
- Troubleshooting ....................................................... 2

### U
- Updates ................................................................. 1

### W
- What is the MCP250XX Development Kit? ..................... 5